PRINCIPAL RECIPIENT MANAGEMENT DASHBOARD INSTALLATION AND SETUP GUIDE

Version 2.0 R4—August 15, 2017

Management tools for the whole-of-country approach

CCM Summary
Regional Dashboard
Principal Recipient Management Dashboard
Subrecipient Management Tool
This publication is made possible by the support of the American People through the U.S. Agency for International Development and the U.S. President’s Emergency Plan for AIDS Relief. GMS is funded by the U.S. President’s Emergency Plan for AIDS Relief and the U.S. Agency for International Development under contract No. AID-OAA-C-12-00040. The contents of this report are the sole responsibility of Grant Management Solutions, and do not necessarily reflect the views of the U.S. Agency for International Development, the U.S. government, or the Global Fund to Fight AIDS, Tuberculosis and Malaria. GMS is a U.S. Government–funded partnership consisting of Management Sciences for Health, Abt Associates, International HIV/AIDS Alliance, Pact, Palladium, Realizing Global Health, Training Resources Group, and committed to strengthening the performance of Global Fund grants.
TABLE OF CONTENTS

1. Introduction .................................................................................................................. 6
   1.1. Purpose and organization of the User Guide ............................................................ 6
   1.2. What is a dashboard and how will the PR Management Dashboard help PRs? .... 6
   1.3. How does the PR Management Dashboard work? ................................................... 6
   1.4. Why was the PR Management Dashboard developed? ........................................... 7
   1.5. Who developed the PR Management Dashboard? ............................................... 7
   1.6. Who will be the beneficiaries of the PR Management Dashboard? ....................... 8
   1.7. How was the PR Management Dashboard developed? ........................................... 8
       1.7.1. Initial development ......................................................................................... 8
       1.7.2. User acceptance testing .............................................................................. 9
       1.7.3. Piloting in six countries ............................................................................. 9
       1.7.4. Handover to Global Fund and scale up ....................................................... 10
   1.8. How the PR Management Dashboard fits into the whole-of-country approach and
       the suite of management tools ............................................................................ 10

2. Prerequisites for installing and using the PR Management Dashboard ..................... 13
   2.1. Key steps in setting up the PR Management Dashboard ....................................... 13
   2.2. Prerequisites for effective installation of the PR Management Dashboard .......... 13
       2.2.1. Equipment requirements ............................................................................. 13
       2.2.2. System requirements ................................................................................. 14
       2.2.3. Connectivity ............................................................................................... 15
       2.2.4. Key actors involved in dashboard installation and knowledge and skills required
             ..................................................................................................................... 15

3. Step-by-step instructions for installation, configuration and ongoing use of the
   data-entry application .................................................................................................... 18
   3.1. Installing the Excel data-entry application ............................................................ 19
       3.1.1. Obtaining and managing data-entry application files .................................. 19
       3.1.2. Accessing the menu screen ......................................................................... 20
       3.2. Configuring the Excel data-entry application—process 1 ............................... 21
       3.3. Step 1: Configuration > Go to Setup > General information .......................... 22
       3.4. Step 2: Configuration > Go to Setup > SR names ............................................ 24
       3.5. Step 3: Configuration > Go to Setup > Create new SR worksheets .............. 26
       3.6. Step 4: Configuration > Go to Setup > Financial thresholds ......................... 29
       3.7. Step 5: Configuration > Go to Setup > Product monitoring .......................... 32
       3.8. Step 6: Indicator mapping. Configuring the data-entry sheet ................................ 35
           3.8.1. Configuration > Go to setup > Indicator mapping .................................... 35
           3.8.2. Indicator selection process: Financial indicators ...................................... 36
           3.8.3. Indicator selection process: General management indicators .................. 38
           3.8.4. Indicator selection process: Procurement and supply management indicators.. 38
           3.8.5. Indicator selection process: Programmatic indicators ............................. 39
           3.8.6. Indicator selection process: Modifying or replacing standard programmatic
                  indicators .................................................................................................. 42
           3.8.7. Completing selection of programmatic indicators: Generation of the
                  programmatic tables and SR worksheets .................................................. 45
3.8.8. If more changes are needed ................................................................. 46
3.9.  Step 7: Refresh prog indicators list. Configuration > Go to Setup > ... 48
3.9.1. Configuring the data-entry application: Completing the configuration of
programmatic indicators—Step 8: programmatic thesholds. Configuration > Go
to Setup > ................................................................. 48
3.9.2. Step 9: Period dates check. Configuration > Go to Setup> .................. 49
3.9.3. Configuration > Remove SR worksheet ........................................... 50
3.9.4. Step 10: Refresh prog indicators list. Configuration > Go to Setup ...... 52
3.10. Create data input form—PROCESS 2: Select export sheet ............... 52
3.11. Excel data-entry application—PROCESS 3: SR completes SR data-entry sheets
(data collection) ................................................................. 53
3.12. Excel data-entry application—PROCESS 4: Data collection and uploading of SR
files ..................................................................................... 55
3.13. Dashboard data feed–Export master data—PROCESS 5 ..................... 56

4.  Step-by-Step instructions for installation and ongoing use of the PR Management
Dashboard application ........................................................................ 59
4.1. Installing SAP Crystal Dashboard Design 2011 (PR Management Dashboard
software) ......................................................................................... 59
4.1.1. Ensuring the version of Excel on the PR’s computer is compatible with dashboard
software ......................................................................................... 59
4.1.2. Installing the dashboard software .................................................. 61
4.1.3. Additional dashboard set-up steps ................................................. 68
4.2. Navigating the dashboard ................................................................. 70
4.2.1. Import grant data into PR Management Dashboard ....................... 70
4.2.2. Data import into the PR Management Dashboard ....................... 72
4.2.3. Visualization of the PR Management Dashboard ......................... 74

5.  The PR Management Dashboard in detail ........................................... 75

6.  Troubleshooting: best practices, frequently asked questions (FAQs) and the help
desk ..................................................................................................... 84
6.1. FAQs on the data-entry application .................................................. 84
6.2. FAQs on the PR Management Dashboard ......................................... 87
6.3. How to get help with the PR Management Dashboard ....................... 90
## ABBREVIATIONS AND ACRONYMS

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCM</td>
<td>country coordinating mechanism</td>
</tr>
<tr>
<td>Global Fund</td>
<td>Global Fund to Fight AIDS, Tuberculosis and Malaria</td>
</tr>
<tr>
<td>GMS</td>
<td>Grant Management Solutions</td>
</tr>
<tr>
<td>IT</td>
<td>information technology</td>
</tr>
<tr>
<td>LFA</td>
<td>local fund agent</td>
</tr>
<tr>
<td>MSH</td>
<td>Management Sciences for Health</td>
</tr>
<tr>
<td>OGAC</td>
<td>Office of the U.S. Global AIDS Coordinator</td>
</tr>
<tr>
<td>PEPFAR</td>
<td>U.S. President’s Emergency Plan for AIDS Relief</td>
</tr>
<tr>
<td>PR</td>
<td>principal recipient</td>
</tr>
<tr>
<td>PSM</td>
<td>procurement and supply management</td>
</tr>
<tr>
<td>SC</td>
<td>special condition</td>
</tr>
<tr>
<td>SR</td>
<td>subrecipient</td>
</tr>
<tr>
<td>SRMT</td>
<td>Subrecipient Management Tool</td>
</tr>
<tr>
<td>SSR</td>
<td>sub-SR</td>
</tr>
<tr>
<td>UAT</td>
<td>user acceptance testing</td>
</tr>
<tr>
<td>USAID</td>
<td>U.S. Agency for International Development</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus/flash drive</td>
</tr>
<tr>
<td><strong>User Guide</strong></td>
<td><strong>Principal Recipient Management Dashboard Installation and Setup Guide</strong></td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1. PURPOSE AND ORGANIZATION OF THE USER GUIDE

This user guide is intended to help principal recipients (PRs) and their subrecipients (SRs) understand the purpose of the PR Management Dashboard, the prerequisites for using it, the specific steps for installing, setting up and using the dashboard, as well as the layout of the dashboard. This user guide, Principal Recipient Management Dashboard Installation and Setup Guide (User Guide for short), is therefore divided into three major parts: (1) an introduction, which explains the origins, purpose, development and plans for the PR management dashboard, all in sections 1 and 2 of this User Guide; (2) step-by-step instructions for using the data-entry and dashboard-display applications that comprise the PR Management Dashboard, all in sections 3-6 of this User Guide, and (3) annexes, which include detailed information on dashboard indicators.

1.2. WHAT IS A DASHBOARD AND HOW WILL THE PR MANAGEMENT DASHBOARD HELP PRS?

A dashboard is visual display of the most important information needed by managers and executive-level decision-makers to monitor progress towards objectives for a project or organization. By using dashboard data for timely identification of problems and bottlenecks in program implementation, managers and decision-makers can take corrective actions to improve program performance.

The PR Management Dashboard provides PRs with a user-friendly, highly visual mechanism for obtaining a snapshot of the performance of their grants at a given point in time. Through color coding and a drill-down mechanism, the dashboard guides the PR's analysis of its performance and thus gives the PR an opportunity to detect problems with grant performance early and to take fast action to get the grant back on course.

Many Global Fund grants are implemented through partnership arrangements by subcontracting grant activities to national and local SRs. The number of SRs per PR can vary greatly, and each SR must report on expenditures, implementation and results to the PR. Through its drill-down functionality, the dashboard allows the PR to view the performance of each SR as measured by several indicators, and allows the PR to compare the performance of SRs contributing to the same indicator. After reviewing these data, the PR can then take action to strengthen underperforming SRs.

1.3. HOW DOES THE PR MANAGEMENT DASHBOARD WORK?

The PR Management Dashboard comprises two applications that are used together: an Excel-based data-entry application and a dashboard-display application that uses SAP Crystal Dashboard Design 2011 software. When used together, these two applications allow the display of a selection of general management, financial, procurement and supply management, and programmatic indicators that inform the PR on a grant’s “vital signs.” Data collected at the SR level are uploaded by the PR into the dashboard and
combined with other data collected by the PR for display, analysis and use in decision making. Information generated by the dashboard is meant for review on a periodic basis (monthly, quarterly). It is expected that the PRs will make use of the dashboard to inform country coordinating mechanisms (CCMs) of grant performance and that dashboard data may be used to produce documents routinely submitted to the Global Fund Secretariat.

1.4. WHY WAS THE PR MANAGEMENT DASHBOARD DEVELOPED?

Since 2006, GMS has developed three dashboards for Global Fund countries: two PR management dashboard prototypes (using Excel and Xcelsius) and one CCM oversight dashboard. The CCM dashboard was piloted with the Global Fund Secretariat in 2009 and is available to CCMs through the Global Fund website at www.theglobalfund.org/en/country-coordinating-mechanism/oversight/. The PR Management Dashboard is based on the earlier prototypes of PR management dashboards introduced in Honduras and Nicaragua, respectively in 2006 and 2008.

The initiative to develop an enhanced version of early PR dashboard prototypes is a follow-up to findings from the 2012 impact evaluation of introduction of the CCM dashboard, which found strong demand among PRs for a more detailed grant management dashboard that would allow them to visualize and compare performance of their SR implementing partners, as well as to produce the CCM oversight dashboard and Global Fund required reports. These findings appear in the report, Strengthening County Coordinating Mechanisms for Effective Oversight Including Introduction of Grant Dashboards: Follow-Up of Twenty-Four Country Coordinating Mechanisms. can be found on the GMS website at www.gmsproject.org/news/index.cfm.

Improvements over earlier versions used in Honduras and Nicaragua include the following:

- Organization of data for all types of indicators (financial, management and programmatic), including a wider range of procurement and supply management indicators
- Submission of data by SRs can now be done by email and forms with data can be uploaded directly into a master data file
- Creation of a semi-automated mechanism for uploading SR data into a PR master data file, which reduces transcription errors that could result from cutting and pasting
- Visualization of PR data with drill-down to SR data for certain indicators
- Comparison of performance among SRs for certain indicators

1.5. WHO DEVELOPED THE PR MANAGEMENT DASHBOARD?

The USAID-funded project Grant Management Solutions (GMS), the secretariat of the Global Fund to Fight AIDS, Tuberculosis and Malaria (Global Fund Secretariat and
Global Fund, for short), and a private-sector partner, German IT multinational SAP,\(^1\) jointly developed the PR Management Dashboard to support and improve grant management by PRs of the Global Fund. Staff from various teams within the Global Fund Secretariat worked with staff from GMS and SAP and contributed to the selection of dashboard indicators. In addition, six PRs in five countries (India, Nepal, Myanmar, Democratic Republic of the Congo, and Honduras) validated the indicators for the PR Management Dashboard.\(^2\)

1.6. **WHO WILL BE THE BENEFICIARIES OF THE PR MANAGEMENT DASHBOARD?**

The main beneficiaries of the PR Management Dashboard will be PRs and SRs. PRs sign grant agreements with the Global Fund and are legally responsible for the performance of those grants. PRs are usually ministries of health or finance, national or international nongovernmental organizations, UN agencies, or in some cases private-sector institutions with significant health programs. Since Global Fund grants involve implementing partnerships, PRs select and subgrant to national and local SRs whose number may range from one to over 200, each of whom must report on expenditures, implementation and results to the PR. Many SRs also have sub-SRs (SSRs) as well. There are currently 296 PRs in 140 countries managing 472 active grants with a signed value of $14.9 billion.

Other stakeholders who will benefit from information generated from dashboards are SSRs and CCMs. In addition, local fund agents of the Global Fund (LFAs) and Global Fund staff who are concerned about the performance of a grant will be interested in information generated by the dashboard.

1.7. **HOW WAS THE PR MANAGEMENT DASHBOARD DEVELOPED?**

1.7.1. **INITIAL DEVELOPMENT**

The PR Management Dashboard was developed through a collaboration of GMS, the Global Fund Secretariat and SAP, using a standard software development process. High-level data and functional requirements were first identified by the Global Fund, GMS and SAP. GMS and the Global Fund selected financial, general management and procurement and supply management indicators, and validated these with six PRs. Design of the dashboard and its accompanying data-entry template then proceeded, and an in-house test was then conducted to ensure that both key elements of the PR Management Dashboard functioned correctly.

\(^1\) SAP is a German multinational corporation founded in 1972 which specializes in developing software for managing business operations and customer relations. SAP stands for Systeme, Anwendungen und Produkte in der Datenverarbeitung (“Systems, Applications and Products in Data Processing”).

\(^2\) The PRs that validated dashboard indicators were CHF (Honduras); *Projet Santé Rurale*, or SANRU (Democratic Republic of the Congo); International AIDS Alliance (India); and Save the Children (Myanmar and Nepal).
1.7.2. USER ACCEPTANCE TESTING

The in-house test was followed by user acceptance testing (UAT) in the Dominican Republic to confirm that the dashboard could be used by a PR and SRs under real field conditions and to verify that most if not all data required to generate dashboard information could be obtained. Lessons learned from UAT resulted in adjustments to both the dashboard-display application and data-entry application.

1.7.3. PILOTING IN SIX COUNTRIES

The PR Management Dashboard was piloted in six countries between February and August 2014: Cote d’Ivoire, the Dominican Republic, Laos, Senegal, South Africa, and Uganda. Pilot countries received a limited number of SAP Crystal Dashboard Design 2011 licenses, which are required for producing the dashboard. The six countries also received a package of technical support from GMS over three visits to accompany deployment of the dashboard. This technical support comprised a guided introduction to the PR Management Dashboard and support for ongoing use of the dashboard. Technical support included support for installation, adoption, operation, and maintenance of the dashboard, as well as assistance to upgrade and improve PR/SR grant management systems, processes, and practices, and subsequently, grant performance.

The pilot was a success. In each of the six countries PRs and SRs were trained in installation and use of the dashboards, the various types of data needed to produce the dashboard were collected, and the dashboards were produced. Five countries each produced dashboards for one grant; dashboards were produced for two grants in one country (this was in Senegal, which had a dual track grant with two PRs). Most pilot countries explained and discussed dashboards produced with in-country key stakeholders, which, depending on the country, ranged from SRs, to CCM members, and donors. Some countries experienced extensive engagement from Global Fund portfolio managers during the pilot. GMS has continued to monitor the use of dashboards after the final technical assistance pilot visits to understand more about the factors influencing adoption and use of dashboards, and to determine how the PR Management Dashboard will affect grant performance.
1.7.4. HANDOVER TO GLOBAL FUND AND SCALE UP

Following pilot testing, further modifications were made to the PR Management Dashboard based on lessons drawn from the pilots. English, French, Portuguese, and Spanish versions of the software and accompanying user documentation were updated. The dashboard and its accompanying document were then handed over to the Global Fund for dissemination at the global level.

1.8. HOW THE PR MANAGEMENT DASHBOARD FITS INTO THE WHOLE-OF-COUNTRY APPROACH AND THE SUITE OF MANAGEMENT TOOLS

The PR Management Dashboard is one of a suite of four management tools created to help Global Fund countries monitor and improve their grant performance. The full suite consists of the following tools in order of creation:

1. PR Management Dashboard, developed by GMS, the Global Fund Secretariat and SAP SE in 2013
2. CCM Summary, developed by GMS
3. Regional Dashboard, developed by GMS
4. Subrecipient Management Tool (SRMT), developed by GMS

The Global Fund has adopted the PR Management Dashboard and the CCM Summary; these tools are progressively being made available on the Global Fund’s website at www.theglobalfund.org/en/funding-model/technical-cooperation/management-tools/.

The four tools and their main characteristics are shown in the table on the following page, where the arrows in the left column indicate the flow of data between tools.
<table>
<thead>
<tr>
<th>Management tool</th>
<th>Main characteristics</th>
<th>Data input</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CCM Summary</strong></td>
<td>➢ Uses an Excel-based application for data entry and an SAP Crystal Dashboard Design 2011 application for visualization  &lt;br&gt; ➢ Shows quarterly results by summing PR grant data  &lt;br&gt; ➢ Presents indicator data for up to three years  &lt;br&gt; ➢ Performance data are organized by component (HIV/AIDS, TB, malaria, HSS) and by PR within each component  &lt;br&gt; ➢ Contains section for recording recommendations by CCM oversight body, decisions by CCM and status of implementation of recommended actions</td>
<td>Configuration is done by the CCM; PR data are imported from the PR Management Dashboard</td>
</tr>
<tr>
<td><strong>Regional Dashboard</strong></td>
<td>➢ Uses an Excel-based application for data entry and an SAP Crystal Dashboard Design 2011 application for visualization  &lt;br&gt; ➢ Shows quarterly results by summing SR grant data  &lt;br&gt; ➢ Presents indicators data for up to three years  &lt;br&gt; ➢ Presents information aggregated by country  &lt;br&gt; ➢ Has a map of countries involved</td>
<td>Data imported from the PR Management Dashboard Excel-based Data Master</td>
</tr>
<tr>
<td><strong>PR Management Dashboard</strong></td>
<td>➢ Uses two applications - an Excel-based data-entry component and a visualization application that uses SAP Crystal Dashboard Design 2011  &lt;br&gt; ➢ Displays overall grant data on one page  &lt;br&gt; ➢ Drill down layer displays quarterly and cumulative life of grant results by SR  &lt;br&gt; ➢ Presents indicators data for three years</td>
<td>PR data entered directly by PR; SR data imported by uploading SR data-entry sheets for each SR</td>
</tr>
<tr>
<td><strong>SR Management Tool</strong></td>
<td>➢ Consists of a single, Excel-based application  &lt;br&gt; ➢ Configuration is led by the PR in close collaboration with SRs  &lt;br&gt; ➢ Displays quarterly and annual cumulative data for one year  &lt;br&gt; ➢ Includes summary of SR performance using both tables and charts</td>
<td>Following configuration by PR, data entry is done by SRs</td>
</tr>
</tbody>
</table>

The PR Management Dashboard, CCM Summary and SRMT are interlinked: the SRMT produces sheets that feed into production of the PR Management Dashboard, and the PR Management Dashboard in turn produces files that are used to create the CCM Summary. Two versions of the regional dashboard exist. One is a version of the PR Management Dashboard configured (and possibly modified slightly in design) for regional grants with simple implementation arrangements. The second version is designed for regional grants with more complex implementation arrangements and uses multiple applications—the Excel-based PR Data Master, the Excel-based Regional Data Master and an SAP-based visualization application—to produce the actual dashboard.
2. PREREQUISITES FOR INSTALLING AND USING THE PR MANAGEMENT DASHBOARD

2.1. KEY STEPS IN SETTING UP THE PR MANAGEMENT DASHBOARD

The following are the key steps involved in setting up the PR Management Dashboard:

- Installing the data-entry application at PR level
- Installing the SAP Crystal Dashboard Design 2011 software at PR level
- Configuring the dataentry application with basic information about the grant including:
  - Entering general information about the grant
  - Entering all SRs for the grant
  - Setting thresholds for financial management indicators
  - Selecting pharmaceuticals to be tracked and indicating their safety stock levels
  - Selecting programmatic indicators to appear in the dashboard and setting their thresholds
  - Mapping programmatic indicators to SRs
- Generating SR data-entry sheets and sending them to SRs

Sections 3 and 4 of this document lay out these steps in more detail.

2.2. PREREQUISITES FOR EFFECTIVE INSTALLATION OF THE PR MANAGEMENT DASHBOARD

The PR Management Dashboard is designed to be usable in both high information technology (IT) and low IT environments. This section describes the systems, technical requirements, key actors and related knowledge and skills that should be in place and available for effective installation and use of the PR Management Dashboard.

2.2.1. EQUIPMENT REQUIREMENTS

To use the dashboard effectively, the PR will need the following equipment:

- Laptop or desktop computer
- Internet connection
- Capability of periodic storage of data files (hard disk, USB, other storage device)
- Color printer

It is desirable for SRs to have at least one laptop or desk computer, as well as the capability to store data as detailed above.

3. Low IT capacity refers to countries characterized by: poor availability of computers at most levels of their health systems, problems with internet connectivity and bandwidth, as well as weak human and infrastructure capacity to support use of computer technology for data collection, transfer and processing. High IT capacity countries have ready availability of computers at most levels of the health system, good internet connectivity and speed. Additionally, high IT capacity countries have an adequate supply of human resources capable of using computer technology for data collection, transfer and processing.
2.2.2. SYSTEM REQUIREMENTS

To use the PR Management Dashboard, PRs will need administrator’s rights to install new software on computers and laptops on which the dashboard will be used. Administrator rights are also necessary in case the PR has to reinstall Microsoft Office to select the version (32-bit) that is compatible with SAP Crystal Dashboard Design 2011.

**PRs** must have the following software versions (any one from the list for each product) already installed on their computer(s), to install and run SAP Crystal Dashboard Design 2011.

**Microsoft Windows**

Windows XP Professional SP2 and SP3
Windows Server 2003 standard edition SP1 and SP2
Windows Server 2003 Enterprise Edition SP1 and SP2
Windows Vista SP1 and SP2
Windows 7
Windows 8
Windows 10
Windows Embedded Compact 2013

**Microsoft Excel**

Excel XP SP3 (or later)
Excel 2003 SP1, SP2, SP3
Excel 2007 32-bit version (64-bit is not compatible with the dashboard software)
Excel 2010 32-bit version (64-bit is not compatible with the dashboard software)
Excel 2013 32-bit version (64-bit is not compatible with the dashboard software)

Adobe Reader 11 or later version
Adobe Flash Player 15 or later version

**Antivirus**

Updated antivirus software

Last, the PR will require **SAP Crystal Dashboard Design 2011**. The PR will receive the requisite software license number from the Global Fund Secretariat, which will maintain a list of licenses and issue them to approved PRs.

**SRs** have the following minimum software requirements to effectively enter data into SR data-entry sheets and transmit them to the PR. SRs will not require software licenses to view the dashboards produced by PRs and will therefore not be issued licenses.
Microsoft Windows
Same as specified above for the PR (see above)

Microsoft Excel
Same as specified above for the PR (see above)

Antivirus
Updated antivirus software

2.2.3. CONNECTIVITY

It is assumed that the computers that the PR would use for purposes of the dashboard have access to a functional internet connection. In cases where the internet connection is not reliable, however, files can be transferred using USB flash drives or CD-ROMs. It is desirable that SRs also have access to a functional internet connection.

2.2.4. KEY ACTORS INVOLVED IN DASHBOARD INSTALLATION AND KNOWLEDGE AND SKILLS REQUIRED

The PR coordinates dashboard set up in collaboration with lead SRs. The table below identifies key staff from the PR and other stakeholders who would be involved in installation and setup of the PR Management Dashboard, their key responsibilities and the requisite knowledge and skills.
<table>
<thead>
<tr>
<th>Actor</th>
<th>Key responsibilities with dashboard setup and use</th>
<th>Skills and knowledge required</th>
</tr>
</thead>
</table>
| PR Program Manager for the grant | • Assign responsibility for producing dashboard within PR staff  
• Select grants for which dashboards will be used  
• Coordinate selection of indicators that will appear in dashboard  
• Oversee production of dashboards and hold periodic meetings to review results  
• Present results at CCM meetings  
• Coordinate validation of dashboard data  
• Make and record decisions  
• Follow up on decisions made | • Thorough familiarity with grant activities |
| PR Dashboard Data Manager (likely to be PR Monitoring and Evaluation (M&E) Officer) | • Conduct mapping of PR indicators to SRs  
• Assess SR capacity to report on the data  
• Train PR staff and SRs in the use of the standardized Excel data-collection instruments, in the identification of primary data sources, and in the process of sending data sets to the PR  
• Monitor submission of data by SRs, including data quality  
• Periodically enter PR data into master data sheet  
• Conduct quality checks for completeness and coherence of data  
• Ensure proper archiving of dashboard files  
• Conduct periodic backup of dashboard data  
• Guide supervision of SRs that are weak performers.  
• Ensure timely transmission of dashboards to the CCM secretariat  
• Lead analysis, revision and updating of the processes and procedures for monitoring, supervision and evaluation of SRs and PR  
• Develop or update monitoring guide for SRs | • Competency in SAP Crystal Dashboard Design 2011, Microsoft Excel, file safeguarding, internet use  
• Training and experience in M&E or program oversight/performance monitoring  
• Thorough familiarity with grant activities |
| PR Finance Officer(s) | • Provide budget information to M&E Officer for insertion into dashboard | • Competency in Microsoft Excel, file safeguarding, internet use  
• Experience in financial management of |
<table>
<thead>
<tr>
<th>Actor</th>
<th>Key responsibilities with dashboard setup and use</th>
<th>Skills and knowledge required</th>
</tr>
</thead>
<tbody>
<tr>
<td>PR procurement and supply management (PSM) manager</td>
<td>Select health products to track through dashboard&lt;br&gt;Confirm data sources for measuring PSM indicators&lt;br&gt;Identify and develop tools and processes required to support data collection&lt;br&gt;Liaise with central medical stores or other data sources, as needed, to obtain regular, timely data on PSM indicators</td>
<td>Sufficient understanding of link between pharmaceuticals and health products by grant and the overall program being executed through the grant&lt;br&gt;Sound understanding of the structure and functioning of the pharmaceutical supply system for the country&lt;br&gt;Thorough familiarity with grant finances</td>
</tr>
<tr>
<td>SR dashboard data manager (likely to be the SR M&amp;E officer)</td>
<td>Timely transmission of performance data to the PR using Excel sheets generated by data-entry application&lt;br&gt;Review dashboards generated by PR and provide feedback&lt;br&gt;Review implementation of follow-up</td>
<td>Competency in Microsoft Excel, file management and internet use.&lt;br&gt;Thorough familiarity with grant activities</td>
</tr>
<tr>
<td>PR IT manager (if applicable)</td>
<td>Support PR in generating dashboard&lt;br&gt;Support PR in troubleshooting dashboard-display application and data-entry application</td>
<td>Competency in SAP Crystal Dashboard Design 2011 and Microsoft Excel, file management, and internet use.&lt;br&gt;Experience working with data export and import from and into Excel&lt;br&gt;Knowledge or understanding of relational databases is desirable&lt;br&gt;Experience with reporting errors&lt;br&gt;Experience with troubleshooting</td>
</tr>
<tr>
<td>CCM oversight committee</td>
<td>Review dashboard information provided by PR&lt;br&gt;Follow up with PR to ensure implementation of follow-up actions to mitigate problems and address poor performance</td>
<td>Basic knowledge on the Global Fund grant cycle&lt;br&gt;Understanding of how to interpret dashboard indicators</td>
</tr>
</tbody>
</table>
3. **STEP-BY-STEP INSTRUCTIONS FOR INSTALLATION, CONFIGURATION AND ONGOING USE OF THE DATA-ENTRY APPLICATION**

As mentioned in the previous sections of this manual, the PR Management Dashboard comprises two elements—the data-entry application and the dashboard-display application—which must be used sequentially. The diagram below guides the user through specific steps to set up and use the PR Management Dashboard. The steps required to produce the dashboard mirror the flow of data in the PR’s monitoring and evaluation process. The PR must follow all the steps in the correct order to effectively produce a dashboard. This diagram represents all the steps described in sections 3 and 4 of this manual.

**Key steps for producing the PR Management Dashboard**

- **A** The PR configures the dashboard, then generates data entry sheets and distributes one to each SR.
- **B** SRs complete data entry sheets with current and historical data, and return them to the PR.
- **C** The PR uploads SR data entry sheets to the Data Entry Application and consolidates this with PR data in the PR Data Master data sheet.
- **D** The PR exports data files from the PR Master Data sheet to Dashboard Feed file.
- **E** The PR imports data files into SAP Crystal Dashboard Designer 2011 and generates the dashboard; Using Adobe Flash Player, PR generates interactive files that the SR can view.
- **F** The PR analyzes dashboard output, makes decisions on actions to take to improve performance.

Section 3 describes “A,” “B” “C” and “D” in the diagram, how to use the data-entry application, from beginning to end. Subsections 3.1 to 3.13 walk the user through installation, setup and use of the data-entry application.
Section 4 explains “E” in the diagram, step-by-step use for the dashboard-display application. A more detailed diagram of the process of the PR Management Dashboard is included in annex 1 of this User Guide.

PRs receiving technical support for dashboard introduction will receive assistance with understanding and implementing “F” in the diagram.

3.1. INSTALLING THE EXCEL DATA-ENTRY APPLICATION

This section explains how to obtain and install the data-entry application, which is one of the two major elements of the PR Management Dashboard.

The data-entry application is an Excel spreadsheet that will enable PRs to

- Configure basic information about the grant, the PR, SRs, indicators and their thresholds
- Produce data-entry sheets for up to 49 SRs
- Export data-entry sheets to each SR
- Import SR data so that they are integrated with PR data into one master data sheet
- Export data to the dashboard

An additional file – the dashboard feed file – is used with the data entry application to export data to produce the dashboard.

3.1.1. OBTAINING AND MANAGING DATA-ENTRY APPLICATION FILES

The PR will obtain the data-entry application file either from the technical team assisting the PR with introducing the dashboard on a USB, or directly from the Global Fund website.

To begin the process of setting up a file structure for and uploading the data-entry application and dashboard feed file, GMS recommends that the PR follow these steps:

A. Create a folder in the computer hard disk where the PR Dashboard will be hosted. This folder shall be named **PR Dashboard**
B. Create a folder under **PR Dashboard** called **Master Files**
C. Create similar subfolders under **PR Dashboard** for each grant and each fiscal year, effectively making a logical file architecture for all PR Management Dashboard-related files.

A sample file architecture follows:

**A. PR Dashboard**
B. PR Dashboard \ Master Files_Version [XXX]\n
C. PR Dashboard \ Master Files_Version [XXX]\Grant [fill in name of grant #x]

1. Grant #1

   PR Dashboard \ Grant [fill in name of grant #1]\Grant Period 1_ [fill in [Day]_[Month]_[Year] for grant #1]\[Fill in file name, such as “master data file”]

2. Grant #2

   PR Dashboard > Grant [fill in name of grant #2]\ [continue with file names as above for grant #1 for each additional grant]

Following the sample architecture above, an example of file naming might be as follows:

A. PR Dashboard

B. PR Dashboard \ Master Files_Version [XXX]\n
C. PR Dashboard \Grant CCC-111-G12-M

   PR Dashboard \Grant CCC-111-G12-M\Grant Period 2_27_June_2013\Master data file

   PR Dashboard \Grant CCC-111-G12-M\Grant Period 2_27_June_2014\[other file names as above]

   PR Dashboard \Grant CCC-113_G13-T [continue with file names as above for grant CCC-111-G12-M for each additional grant]

The PR may prefer to use a different file architecture with different file naming conventions. This is fine. What matters is that the PR create a system for naming and archiving all files related to the dashboard that (1) is unique, (2) follows a logic that makes sense to its users, (3) is easy to read quickly, and (4) is easy to always use and IS always used. The PR may want to consult best practices on naming conventions; several guides can be found on the Internet by Googling “file naming conventions.”

3.1.2. ACCESSING THE MENU SCREEN

When the PR opens the copied Excel file, the MENU page will pop up, showing four processes to be followed, as well as a log to track changes made.
NOTE: On occasion the Excel version in use may show the following message at the top of the screen: “Safety warning: macros are disabled” along with a window with options.

If this occurs, *enable macros* and press the “Accept” button.

The **Menu Screen** will appear as shown below:

![Menu Screen Diagram]

### 3.2. CONFIGURING THE EXCEL DATA-ENTRY APPLICATION—PROCESS 1

Decisions on configuring the data-entry application will be made by the PR with support from any technical assistance provider helping the PR. Usually, these decisions will be made during a facilitated indicator workshop. Decisions and choices will be documented, to guide the actual configuration actions. The dashboard programmer must refer to the decision document while configuring.

**« GO TO SETUP »**

Within the **Configuration** box, two additional buttons will appear: “Go to Setup” and “Remove SR Worksheet.”

![Configuration Box Diagram]

The “Go to Setup” button is critical for operation of the dashboard, since it allows for definition of general PR information, SR data entry, indicator selection and threshold definition, product identification, and periods considered for monitoring.

Below are step-by-step instructions for the PR for each of the options included in the submenu screen.
When configuring the data-entry application, remember to refrain from cutting and pasting data into the dashboard, as cutting and pasting could disturb the programming in the Excel sheets.

**Configuration > Go to Setup:**

When “Go to Setup” is selected, the following screen will appear, showing the nine configuration steps or options:

![Configuration Steps](image)

The **PRSetup** button provides a submenu (shown enlarged in the above graphic) which depicts all 9 steps to be carried out to complete PR configuration. Initially, the first step will have a yellow exclamation mark next to it. The subsequent steps will each have an “X” next to them. As soon as the PR begins entering data into “General Grant Information,” a “✓” will appear next to the “General Grant Information” menu item. As each subsequent step is completed, a “✓” will appear to indicate successful completion. If an “X” appears instead, this indicates that the step has not been completed. All steps should be marked with a “✓” before the data-entry application can be used.

This screen also shows a large black arrow, which reads **Return to MENU**. Click on this arrow to return to the main menu.

### 3.3. **STEP 1: CONFIGURATION > GO TO SETUP > GENERAL INFORMATION**

Step 1, selecting **GENERAL INFORMATION**, enables entry of general PR information.

Some cells require the person configuring the dashboard to enter text directly, and other cells have drop-down menus. General information includes information such as language, country, grant title, grant number, PR name, latest rating, phase start date, phase end date, component, round, currency, date of last rating, current period, and last updated.

---

4. Cells with dropdown menus

phase end date, component, round, currency, date of last rating, current period, current period number, and last update. Values for the last two elements (current period number and last rating) are generated automatically.

In order for the program to recognize that this section has been completed, the PR must enter data into the row titled “Round”; the “Round” data could be a number, or the designation “SSF” or “TFM” or whatever applies to the particular grant: the field cannot be left blank. Please note that the numbers for the period in the dashboard may not correspond to numbers for the periods in the grant’s Progress Update and Disbursement Requests PUDRs.

NOTE: The date is entered using the format of DD/MM/YYYY. On certain computers, users will need to enter the data as follows: MM/DD/YYYY for the date to appear correctly. As soon as the date is entered, a “✓” will appear.

Periods are automatically generated as soon as the Phase Start Date is entered in step 1. If this first date is missing or incorrect then the periods shown will be incorrect.

Data that is automatically generated in the Last Updated cell comes directly from the Activity Log on the Menu page of the data-entry application. Therefore, it is important for the PR to update the Activity Log each time to ensure that the Last Updated data is picked up for display on the dashboard.

Remember to save your work!
3.4. **STEP 2: CONFIGURATION > GO TO SETUP > SR NAMES**

Step 2 for **SR NAMES** allows entry of the names of all SRs involved in the grant. Up to 49 SR names may be entered. The PR name appears by default at the top of the list. Although this sheet has several columns, only the shaded column should be filled in. In the shaded column, **each row has a 50-character limit.**

Before SRs names are entered, the sheet appears blank as follows:

![SR Names Sheet](image)

**Important information—concerning the row named Data SR 001:**

The row “Data SR 001” is used as a template for the creation of the rest of the SRs. Users **SHOULD NOT TOUCH** any of the cells in the row corresponding to SR 001, including cell H5, I5, J5 and K5 in the tab "PRSetup," nor should they touch the F column in the "Indicator Mapping" page.

When creating SRs, it is mandatory to put the SR name in the H column first (Step 2) before proceeding to step 3, **"Create New SR worksheets."** If the user executes these actions in reverse order, the data-entry application will show an error message.
In the screenshot below, SR names have already been entered. However, before a user begins to enter names in the column “PR/SRs Names” the menu item “SR Names” will have an “X” next to it. Once the user begins entering SR names in “PR/SRs Names” the “X” will change to a “✓.”

Once SR names are entered, information for the other columns is generated automatically. **DO NOT** manipulate these columns. The user can then proceed with step 3 - Create New SR Worksheets.

**NOTE:** If the PR has no SRs there is no need to create SR names. In this case, only the PR column will appear.

**Remember to save your work!**
3.5. **STEP 3: CONFIGURATION > GO TO SETUP > CREATE NEW SR WORKSHEETS**

Two steps (numbers 3 and 7 in the **Setup** submenu) are macros that automatically execute several predefined processes.

Step 3, **CREATE NEW SR WORKSHEETS**, is a critical step required to set up the indicator mapping. It allows the creation of worksheets for each SR entered in the **SR NAMES** section, in step 2. When “**CREATE NEW SR WORKSHEETS**” is selected, Excel executes a process that will automatically generate a data-entry sheet for each SR added in the previous step. In the case of PRs that have no SRs only the PR worksheet will be generated.

Once the **CREATE NEW SR WORKSHEETS** button is pressed, a dialogue box appears listing the SRs for which worksheets are to be created, as shown below.

![Dialogue Box](image)

When the dialogue box appears above, the PR then presses “**OK**.”

A message will appear as shown in the two screenshots below to indicate that sheets are being created for each SR.
After “OK” is pressed in the “Creation of new SR complete” dialogue box shown above, the “X” then disappears and a “✓” appears instead, indicating that the sheet creation process is complete. This process will take a few minutes. Once the process is completed, a tab corresponding to each SR should appear at the bottom of the screen as shown in the section of the screenshot above that is circled in red. Note that the name of each SR will appear in the tab corresponding for each SR sheet as shown above.

There may be instances where the user creates SRs, then decides that they want to add more SRs after having finished the SR sheet creation process, but before completing the 9 steps of configuration. In this case, all the user needs to do is to press the Create New SR Worksheets button (step 3) once again and a dialogue box for entering the number of new SRs will appear as shown below:
After entering the name of the new SR, click “OK” and a dialogue box to confirm the addition of the new SR will appear as shown below:

Once the user clicks “OK,” the dialogue box appears below indicating completion of the new SR. The user should click “OK” in the dialogue box.

Alternatively, the user can add SRs at this stage by first entering the SR name into the light orange section, and subsequently clicking “Create SR sheets.” A dialogue box will
appear that says: “Hide/ Unhide rows based on current mapping ”. The user should click “OK” to complete the process of creating the sheets.

If the user needs to add several SRs during configuration, the process described above for adding SRs will need to be repeated until all SRs are added.

The process for adding SRs after configuration is complete is much more complex. Please refer to the frequently asked questions section for advice on how to proceed in this situation.

One trick for checking whether the new SR worksheets have been created correctly is to check whether the SR name appearing in column J corresponds to the name in column H.

**Remember to save your work!**

### 3.6. **STEP 4: CONFIGURATION > GO TO SETUP > FINANCIAL THRESHOLDS**

During the process of setting up PR dashboards for grants, thresholds must be determined for financial indicators. In Step 4, **FINANCIAL THRESHOLDS**, the PR defines these thresholds. The Global Fund uses standard thresholds to evaluate financial performance of grants; PRs are therefore encouraged to use these thresholds. It is recommended that threshold setting be done in an indicator-mapping workshop to facilitate obtaining input from various actors involved in implementing the grant.5

During the workshop, the thresholds for the financial indicators “Disbursed” and “Expensed” will need to be finalized by the PRs, and choice of currency to be used in the dashboard will be made.

The thresholds for the “Disbursed” indicator will require careful discussion to ensure that participants can interpret this indicator correctly and that they understand how the ratio of expected disbursements to budget can vary throughout the life of the grant.

PRs are strongly encouraged to harmonize thresholds across grants for a given country portfolio, as this facilitates comparison of performance across grants. Harmonization is easily achieved if PRs use the Global Fund thresholds. However, technical support teams assisting with the introduction of dashboards should be prepared for situations where PRs have good reasons for insisting on different thresholds—for example, insisting on higher thresholds for “green” indicators to challenge the program to attain a higher performance.

---

5. It is recommended that one workshop be held during which decision making on the following be completed: selection of thresholds for financial indicators; selection of programmatic indicators to appear in the dashboard; selection of thresholds for programmatic indicators and; selection of health products to appear on the dashboard; determination of buffer stock amounts to enter in the dashboard for each health product.
Because CCM oversight body members are likely to want to contribute to the determination of thresholds, their participation in the indicator-selection workshop is strongly encouraged. When facilitating the selection of thresholds, technical support teams facilitate the negotiation of thresholds between PRs and the CCM oversight body in situations where there is divergence between the thresholds proposed by the PR and those preferred by the CCM oversight body.

For financial indicators in the dashboard, one of three colors will appear—green, yellow or red—to show performance of the indicator against desired progress for a given period. Green indicates attainment of desired progress, yellow indicates inadequate progress, and red indicates extremely inadequate progress.

The PR must establish thresholds for each financial management indicator, which will trigger these colors to appear. To set the thresholds for the three colors to appear, the PR will set the threshold for green, such that any number equal to or above this number will display in green, and for red, such that any number below this threshold will display in red. Any numbers appearing in between will therefore automatically be yellow. As mentioned earlier, it is recommended that the PR select the same financial thresholds as are used by the Global Fund, which are shown in the graphic below with respect to “expensed” thresholds.

Below are two examples of thresholds set for two financial management indicators—disbursements by the Global Fund (cumulative disbursements from the Global Fund to the PR against the cumulative budget) and the expense rate (cumulative expenditures against cumulative budget):

**Disbursements**

<table>
<thead>
<tr>
<th>Color</th>
<th>Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Green</strong></td>
<td>Greater than or equal to 112% (≥112%)</td>
</tr>
<tr>
<td><strong>Yellow</strong></td>
<td>Less than 112% and greater than or equal to 100% (&lt;112% and ≥100%)</td>
</tr>
<tr>
<td><strong>Red</strong></td>
<td>Less than 100% (&lt;100%)</td>
</tr>
</tbody>
</table>
Expensed

With respect to the “Expensed” indicator, PRs will be encouraged by technical-support teams to apply the Global Fund’s standard thresholds. These can be fixed for the life of the grant as follows.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Greater than or equal to 90% (≥90%)</td>
</tr>
<tr>
<td>Yellow</td>
<td>Less than 90% and greater than or equal to 60% (&lt;90% and ≥60%)</td>
</tr>
<tr>
<td>Red</td>
<td>Less than 60% (&lt;60%)</td>
</tr>
</tbody>
</table>

The PR must enter the finance indicator thresholds into the light orange section of the Data Master sheet, as shown in the image below. Once finance thresholds are entered, a “✓” will appear by the **FINANCIAL THRESHOLDS** menu item as shown below. Note that the thresholds in the example below are different than those shown in the tables above. The screenshot below shows where the thresholds are entered into the data master file. For the disbursed indicator Fi2, any result greater than or equal to 115% will appear in green in the dashboard. For the disbursed red threshold 100% is entered because any result for this indicator below 100% will appear in red in the dashboard. Any result less than 115% and greater than or equal to 100% will appear in yellow in the dashboard. The same logic applies to entering the thresholds for the indicator Expensed Fi3.

**Remember to save your work!**

The table below shows an example of annual disbursement thresholds by year customized by PR. Please note that the CCM may choose to change thresholds, and if the CCM does choose to change thresholds, doing so will only be possible if all the grants in question have the same start date.

### Annual disbursement thresholds:

<table>
<thead>
<tr>
<th>Threshold</th>
<th>Year 1</th>
<th>Year 2</th>
<th>Year 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Green</strong></td>
<td>Greater than 125%</td>
<td>Greater than 112.5%</td>
<td>Greater than 100%</td>
</tr>
<tr>
<td></td>
<td>(&gt;125%)</td>
<td>(&gt;112.5%)</td>
<td>(&gt;100%)</td>
</tr>
<tr>
<td><strong>Yellow</strong></td>
<td>Less than or equal to 125% and greater than 100%</td>
<td>Less than or equal to 112.5% and greater than 100%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(≤125% and &gt;100%)</td>
<td>(≤112.5% and &gt;100%)</td>
<td></td>
</tr>
<tr>
<td><strong>Red</strong></td>
<td>Less than or equal to 100%</td>
<td>Less than or equal to 100%</td>
<td>Less than or equal to 100%</td>
</tr>
<tr>
<td></td>
<td>(≤100%)</td>
<td>(≤100%)</td>
<td>(≤100%)</td>
</tr>
</tbody>
</table>

In year 1, the Global Fund usually advances a quarter of the Year 2 budget. Thus, in the table above, the expected disbursement in year 1 is shown as 125% of the year 1 budget. The threshold for year 1 is greatest because the advance is a greater proportion of the total budget (one quarter advance = 25%). In year 2, the advance is still one quarter, but as a proportion of the cumulative budget this is only 12.5%. The situation is different in year 3 because by the end of a three-year period the PR should have received all the budgeted funds, and if it has the indicator will show as green. The yellow color does not appear in year 3. If all funds are not disbursed, this is cause for concern and the indicator will show as red.

3.7. **STEP 5: CONFIGURATION > GO TO SETUP > PRODUCT MONITORING**

Among the dashboard indicators used for procurement and supply management (PSM) is “monitoring of stocks of pharmaceutical products.” Step 5, **PRODUCT MONITORING**, allows the PR to enter up to 20 products with their corresponding safety stock amount.
Before this step of configuration begins, the menu item **PRODUCT MONITORING** in the tab labeled “PRSetup Menu” appears, as shown:

![Menu Item](image-url)

**Safety stock amount** is the quantity of a pharmaceutical or health product held to mitigate delays in delivery or a sudden increase in consumption. The safety stock should be **expressed in months of stock**. The safety stock amount is determined by the PR or by the ministry of health, and can vary from one product to another and from one country to another (for the same product). Safety stock is intended to allow the PR to provide the pharmaceutical or health product when needed even if a product takes longer to arrive than planned, or there is an unexpected increase in consumption of the product. In both cases, actual demand may exceed anticipated demand, depleting stock at a quicker rate than planned—hence the usefulness of the safety stock.

The data-entry application has a section that lists various health products. The data, which will be entered periodically, is the current stock on hand.

When the amount of stock on hand entered in the data-entry application is sent to the dashboard application, the dashboard application compares the amount of physical stock on hand with the safety stock amount that was entered for the same product during configuration.

If the amount of stock on hand is less than or equal the safety stock amount, an alert will show in the dashboard (red). If the amount of stock on hand is above the safety stock amount but is less than twice the level safety stock amount, the dashboard shows a yellow alert. If the amount of stock on hand is at least twice the level of safety stock but less than four times the safety stock, this is considered to be a desirable result and a green light will appear. When the current amount of safety stock exceeds four times the amount of safety stock, a purple alert shows, indicating overstock and hence, risk of product expiry.
The image below gives an example:

<table>
<thead>
<tr>
<th>Safety Stock amount: 3 Months</th>
<th>More than 12 months of stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 4 times safety stock amount</td>
<td>Between twice the safety stock amount and four times the safety stock amount</td>
</tr>
<tr>
<td>Between the safety stock amount level and under twice the safety stock amount</td>
<td>Between 6 and 12 months of stock</td>
</tr>
<tr>
<td>Below safety stock amount</td>
<td>Less than 3 months of stock</td>
</tr>
</tbody>
</table>

**Red**: below the established safety stock amount  
**Yellow**: between the safety stock amount and under two times the safety stock amount  
**Green**: between two times the safety stock amount and four times the safety stock amount  
**Purple**: more than four times the safety stock amount

As mentioned above, safety stocks amounts may vary by product. Some countries will define standard ranges for these stock amounts, as illustrated in the following example.
Once the pr has finished filling out the list of pharmaceuticals and health products, the screen will appear as follows:

![Image of pharmaceutical list]

Remember to save your work!

3.8. **STEP 6: INDICATOR MAPPING. CONFIGURING THE DATA-ENTRY SHEET**

3.8.1. **CONFIGURATION > GO TO SETUP > INDICATOR MAPPING**

Step 6, **INDICATOR MAPPING**, allows the PR to customize and allocate indicators at the PR and SR levels through a series of steps. Once these steps are completed, the PR will be able to generate data-entry sheets for each SR.

Before the PR begins the indicator mapping process, the PR set-up menu appears as follows with an “X” next to the **INDICATOR MAPPING** menu item as shown in the screenshot below. The screenshot appears as follows below. This is the default screen that will appear for the indicator mapping.

![Image of PR set-up menu]

When **INDICATOR MAPPING** is selected, the tab titled “**Indicator Mapping**” in the Excel worksheet opens.

The **INDICATOR MAPPING** sheet has 3 columns with predefined data:

- **Column Objectid**: This code helps to identify each indicator. The codes highlighted in green represent targets while those in white represent actuals. This column is protected and cannot be modified.

- **Indicator**: All indicators to be used in the dashboard are listed in this column. This list is predefined. Annexes 2, 3, and 4 of this **User Guide** provides details about each indicator selected for the dashboard.

- **Type**: This column identifies each indicator by type—finance, management, PSM, or programmatic.

Additional SR columns in this section are generated automatically when the PR selects SR names. Multiple columns are provided; one for the PR and one for each of the SRs added using option 3 of the submenu. These columns are recognized by the SR name—previously defined—that appears at the top of each column. You will note that the SR 1 Data column (which corresponds to the Data SR 001 row on the configuration (PRSetup) page and provides the template for the SR data entry sheets) appears as well. However, also note that data will never be entered into this column.

The PR must then mark “✓” from the dropdown menu (for **selected**) or “✗” (for **not selected**) for each indicator for the PR and each SR (except for SR 1, which the user does not touch). If the indicator only applies to the PR, the PR will only mark “✓” or “✗” under the PR column. The PR will mark “✓” under the column for each SR when that SR’s activities contribute to the respective indicator and “✗” if the SR’s activities do not contribute to the indicator. This process is valid for all indicators, whether financial, management, PSM, or programmatic.

As noted above, if the PR has no SRs only the PR column will appear.

### 3.8.2. **INDICATOR SELECTION PROCESS: FINANCIAL INDICATORS**

This section explains the process of selecting types of indicators for the data-entry application. A fictitious, but realistic, example is used to illustrate how this section works.

The process to customize the data-entry sheet begins with the selection of financial indicators. This entails entering data for “**budget**,” “**disbursements**” and “**expenditure**” by period for the PR and for each SR.
The definitions for what is entered for “budget,” “disbursements” and expenditure for the PR and the SRs is different and are shown in the table below.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition for PR</th>
<th>Definition for SR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget</td>
<td>Budget approved by the Global Fund for the entire grant (and therefore in the grant agreement).</td>
<td>Budgets in the subgrant agreement between the PR and the SR.</td>
</tr>
<tr>
<td>Disbursements</td>
<td>Funds received by the PR from the Global Fund during the period, including disbursements made directly by the Global Fund to a pooled procurement mechanism (PPM) on the PR’s behalf.</td>
<td>Funds received by the SR from the PR during the period.</td>
</tr>
<tr>
<td>Expenditure</td>
<td>Money spent by the PR alone, plus, if relevant, any expenditure advised by the Global Fund through a pooled procurement mechanism. PR expenditure does not include disbursements by the PR to SRs.</td>
<td>The sum of both its own expenditure and any disbursements the SR make to its SSRs during the period.</td>
</tr>
</tbody>
</table>

Below follows a discussion of how this Excel sheet would be completed for a PR that has 10 SRs. A given PR may enter data into the data-entry application for any number of SRs up to a total of 49 SRs.

In the example, the “budget,” “disbursements,” and “expenditure” for both the PR and SRs are marked “✓” because both the PR and all SRs are responsible for collecting and reporting data related to these elements. Please note that for the these three indicators, once the “✓” is selected for the PR and for one SR, the “✓” will automatically selected for all SRs, as all SRs will receive funds for the PR and therefore would be required to report on these financial indicators.

---

7 The Global Fund has changed the name of what was known as the “Voluntary Pooled Procurement” mechanism to the “Pooled Procurement Mechanism.” On the Global Fund’s website, both terms can be found. In this User Guide, all references to this mechanism will be simply referred to as the pooled procurement mechanism, or PPM.
With regard to “Financial reports planned” and “Financial reports overdue,” both are marked with a “✓” because both elements represent values for which data are entered for SRs and PRs.

With regard to “Audit actions fulfilled,” “Audit actions not fulfilled but within deadline” and “Audit actions not fulfilled and past the deadline” only the PR column is marked with a “✓” because this information resides solely with the PR.

Please refer to the data definitions in annex 5 for more detailed definitions of these indicators.

### 3.8.3. INDICATOR SELECTION PROCESS: GENERAL MANAGEMENT INDICATORS

As with the previous section, the PR must select management indicators. In the example below, most management indicators are under a PR’s responsibility. In some cases, however, data from SRs may be relevant—such as where key positions for the grant reside in SR organizations.

Please review annex 3 to learn more about general management indicators and annex 5 to review the data definitions for each indicator and which indicators apply to either PR or SRs or to both.

### 3.8.4. INDICATOR SELECTION PROCESS: PROCUREMENT AND SUPPLY MANAGEMENT INDICATORS

This section provides information on selecting PSM indicators.

Under step 3, SR indicator sheets were created. Under steps 5 and 6 described in the prior section, the list of health products managed by the PR and SRs were identified. In step 6, the process of selecting the indicators for the grant continues.

For some grants, SRs may contribute to PSM indicators. An example of this would be when a central medical store is designated as an SR in charge of procuring or storing or distributing pharmaceuticals and health products or some combination of these...
activities. In the diagram below, SR3 conducts procurement for products 1, 2, 3, and 4. This is why three cells are marked as “✓” in the corresponding rows under the SR3 column.

In this example, product status reports are the responsibility of the PR. Therefore, “✓” is marked for “Product status reports planned” and “Product status reports overdue.” Similarly, all elements of the budget for pharmaceutical and health products are the responsibility of the PR and “✓” is therefore marked for these elements.

Please refer to the data definitions in annex 5 for detailed definitions of these and other PSM indicators.

<table>
<thead>
<tr>
<th>Component</th>
<th>Number of Indicators available per disease or component</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIV/AIDS</td>
<td>25</td>
</tr>
<tr>
<td>TB</td>
<td>20</td>
</tr>
<tr>
<td>Malaria</td>
<td>23</td>
</tr>
<tr>
<td>HSS</td>
<td>14</td>
</tr>
<tr>
<td>CSS</td>
<td>2</td>
</tr>
</tbody>
</table>

### 3.8.5. INDICATOR SELECTION PROCESS: PROGRAMMATIC INDICATORS

The indicator selection sheet for programmatic indicators includes a predefined list of indicators for each of the diseases or components. This list comes from the Global Fund’s list of standard indicators (see annex 7). The predefined list allows use of the PR Management Dashboard for any type of grant and any type of PR.

A number of the standard programmatic indicators are reported as rates or percentages. While the indicators can be reported for a grant as a whole, summing figures reported by SRs for these indicators will not produce an accurate figure. Therefore, if these programmatic indicators are selected, they should either (1) be entered for the PR only for the grant as a whole or (2) if they are to be entered for the SRs, refer to the notes in section 3.8.6 below to
understand how to approach indicators expressed as rates or percentages. Please refer to the data definitions in annex 7 for detailed definitions of programmatic indicators.

**Note that the dashboard allows visualization of up to 15 indicators for each grant.** The PR therefore has to prioritize and select up to 15 indicators it wishes to see in the dashboard during this step.

As with the previous sections in this worksheet, “X” is the default for each programmatic indicator. Using the results of the indicator selection workshop, the PR must select the rank order for the top indicators, up to 15. The most important indicator will be ranked 1 and appear at the top of the list; the least important indicator will appear at the bottom of the list. Next, the PR marks “✓” for each indicator to which an SR contributes. This should be done very carefully, cell by cell.

An example of prioritization follows (see PR column). Note that in the example, the PR has prioritized 10 indicators (out of a possible 15, as stated above).

![Screenshot of the dashboard](image)

The screenshot above shows the 25 HIV/AIDS indicators from which the PR may select up to 15 top indicators. The PR column shows the ranking of 1-10 for the selected indicators. The SR columns show “✓” where each SR contributes to one of the ten indicators.

To change the rank of an indicator already ranked, the PR can simply select a new number between 1 and 10 for that indicator.

The PR will still be able to see indicators for other disease components while completing this step by scrolling through the screen. The programmatic indicators for each disease or component appear in a different color. However, the PR should be careful to leave these other sections of programmatic indicators as is, with the “X” default selected for these other sections.
The screenshot below shows the remaining lists of indicators for other diseases and components. Note the different colors used to differentiate among the different groups of indicators (in this case the indicators are for malaria, TB, health systems strengthening and community systems strengthening).
3.8.6. INDICATOR SELECTION PROCESS: MODIFYING OR REPLACING STANDARD PROGRAMMATIC INDICATORS

The PR may wish to include indicators that are not found on the Global Fund’s standard list of indicators. In this situation, the PR may add an indicator by modifying one of the existing indicators in the standard list. This modification may be done by following these steps:

1. Go to the tab for indicator mapping shown in section 3.8.5.

2. Identify from the list of indicators the indicator for the same disease or component that the PR wishes to replace with a modified new indicator. **For new and modified indicators, the PR should be aware that the same formula is used in the data-entry application for all indicators. This means that a PR should take extra care when introducing a new indicator which requires a different formula. See the box on the following pages on special situations with indicators.** The example below shows an indicator that has been selected for replacement with a new indicator.
3. Replace an existing but unnecessary indicator by typing the name of the new or modified indicator in the same cell.

The PR can then update the indicator list by pressing “Refresh top 15.”

Please note that this process of adding modifying or replacing existing indicators can be executed after the PR has ranked its top 15 indicators. However, the PR should remember to provide the new indicator with a rank number as well.

**Indicators measured in both numbers and percentages**

Indicators that are defined in both number and percentage terms will be referred to in the *User Guide* as "Dually Descriptive Indicators." An example of a Dually Descriptive Indicator is “Number and Percentage of infants born to HIV infected women who receive a virological test for HIV within 2 months of birth.” If a Dually Descriptive Indicator will be used in the PR Management Dashboard, then, at the setup stage, a decision must be made whether a number or percentage will be reported. Only one of the two—number or percentage—can be entered and displayed in the dashboard. The label of the indicator should be customized accordingly.

If it is decided to reflect the number, then number figures should be entered both for “Target” and “Result” in order to allow calculation of the indicator’s performance for the period. SRs can report performance against numerical targets set for them where appropriate.

However, if an indicator is defined only as a percentage, or if the decision is made to enter a Dually Descriptive Indicator as a percentage, care must be taken to avoid incorrect aggregation of percentage values.
Frequently, percentages will only be reported on a whole-of-grant basis in which case percentage actuals and targets can be entered by the PR alone to produce the correct portrayal in the dashboard.

However, where several SRs contribute to the result, disaggregated reporting may be necessary. Clearly, addition of SR target percentages would be incorrect (summing performances by SR1 of 70%, SR2 of 75% and SR3 of 80% would result in a figure of 225%).

Further, averaging such a sum to produce 75% would also be incorrect as it would fail to reflect the weightings for the different populations covered by each SR.

In such situations, it is necessary to apportion the grant percentage target among SRs. The following example shows a situation where there are three SRs contributing to an indicator.

In this example, the PR has allocated a coverage target of 70% to all its SRs.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Total Pop</td>
<td>% of Coverage (%)</td>
<td>Target for Coverage (%)</td>
<td>Actual % Achieved</td>
<td>Share of National target (A*B)/100</td>
<td>Share of National Achievement (A*C)/100</td>
</tr>
<tr>
<td>SR1</td>
<td>45</td>
<td>70</td>
<td>80</td>
<td>31.5</td>
<td>36</td>
</tr>
<tr>
<td>SR2</td>
<td>35</td>
<td>70</td>
<td>65</td>
<td>24.5</td>
<td>22.75</td>
</tr>
<tr>
<td>SR3</td>
<td>20</td>
<td>70</td>
<td>75</td>
<td>14</td>
<td>15</td>
</tr>
<tr>
<td>Total</td>
<td>100</td>
<td>70</td>
<td>Average=73.33</td>
<td>70</td>
<td>73.75</td>
</tr>
</tbody>
</table>

**Column A** is the % of the total population covered by each SR.  
**Column B** is the % of coverage that each SR is expected to achieve in its geographic area. This is the same as the national target of 70% coverage, for the sake of simplicity.  
**Column C** is the actual coverage achieved by each SR in its geographic area.  
Now, **Column D** is the target percent *weighted* by the population share. This is the share in the national target for each SR, the percent of national population covered by that SR. The numbers add up to 70%.

**Column E** is the actual coverage achieved *weighted* by the SR’s population share. This can also be added up. This is the percentage of national population reached. Here, SR1 reached 36% of the nation’s population. In this example, the total is 73.75% which is an over achievement.

The grant as a whole has thus performed above expectation with 73.75% of the population covered.


44
If the unweighted average had been used, the achievement would be only 73.33% (average of Column C). Also, it would not have been possible to add up each SR’s achievement.

In this example, if the PR were creating a dashboard for the grant, the SRs would enter the number from Columns D and E as their target and actual in the data-entry application. The total would then be the total target and actual for the grant.

If the PR has allocated percentage targets to SRs, then it should set up a calculation similar to the one in the example above.

The above example highlights the need for care in specifying the data to be reported so that confusion in reporting and interpretation is avoided. Accordingly, the PR will need to assess which approach (numbers or percentages) can best meet reporting objectives while minimizing reporting error.

When to address the above situations?

Both of the above procedures can and need to be addressed at two times:

1. At the start of the PR Management Dashboard year, when targets are being set up
2. During the routine verifications

The PR needs to be conscious of the above when verifying each period’s results, and as such these procedural checks must be incorporated into the PR’s routine verification procedural documents (this is a possible strengthening intervention technical support teams may need to undertake).

3.8.7. COMPLETING SELECTION OF PROGRAMMATIC INDICATORS:

GENERATION OF THE PROGRAMMATIC TABLES AND SR WORKSHEETS

Once selection and prioritization of programmatic indicators is completed then the PR will press the Refresh top 15 button at the top of the indicator selection page. Pressing this button will update the indicator sheet. In the alternative, users can go to the submenu of the "PRSetup" page, and click step 7 "Refresh prog indicators list" which serves the same functionality as "Refresh top 15."
Once the updating of the top ten indicators for this example is completed, the data-entry application will populate the “PRSetup” sheet with the programmatic indicators selected by rank order from 1-10 as shown in the screen shot below:

3.8.8. IF MORE CHANGES ARE NEEDED

Once the PR has completed the process of generating data-entry sheets, it is advisable that the PR review each SR sheet to verify that only indicators selected for that SR in previous steps appear in its corresponding column.

When this ordering process is completed, the PR’s next step is to return to the INDICATOR MAPPING sheet, then press the “Refresh Activation” button

By doing so the PR will request the application to carry out a process to define “data-entry sheets” for each of the SRs. For each SR, only the indicators that had been marked by a “✓” for that SR will appear in the SR data-entry sheet. When the “Refresh Activation” button is pressed the following message appears in a confirmation window:
The PR should select “OK.” The "Refresh activation " process will take the users to each SR worksheet as well as the PR worksheet. As each of these worksheets appear, the same dialog box appears which asks users to "Hide/unhide rows based on current mapping.” Users click "OK" to confirm the activation for that SR worksheet. If users wish to make the process go faster, they can click "Cancel" to skip the activation process for that worksheet. However, users are advised to skip the activation process only if they are 100% sure of not wanting to make any changes to the SR worksheet (e.g. adding a new indicator for SR to report on).

The PR will then observe the generation of data-entry sheets for each of the SRs. This process may take a couple of minutes.

Once the PR has finished the INDICATOR MAPPING in step 6, the “PRSetup” menu will appear as follows with a “✓” “ appearing next to INDICATOR MAPPING on the menu.
3.9. **STEP 7: REFRESH PROG INDICATORS LIST. CONFIGURATION > GO TO SETUP >**

Once steps 1-6 of the indicator **CONFIGURATION** process are done, the PR may wish to change or modify indicators, or change the order of indicators. Such modifications can be made by following the instructions described in section 3.8.6 of this *User Guide* and by subsequently pressing the **REFRESH PROG INDICATORS LIST** button on the submenu.

3.9.1. **CONFIGURING THE DATA-ENTRY APPLICATION: COMPLETING THE CONFIGURATION OF PROGRAMMATIC INDICATORS—STEP 8: PROGRAMMATIC THRESHOLDS. CONFIGURATION > GO TO SETUP >**

Programmatic thresholds are defined in the same way financial thresholds are defined. For programmatic indicators (as with financial indicators) in the dashboard, one of three colors will appear—green, yellow or red—to show performance of the indicator against desired progress for a given period. Green indicates attainment of desired progress, yellow indicates unsatisfactory progress, and red indicates inadequate progress.

Each indicator may have different thresholds and the PR is responsible for determining these thresholds. The Global Fund uses standard thresholds to evaluate programmatic performance of grants; PRs are therefore encouraged to use these thresholds. Below is an example of thresholds set for a programmatic indicator, using the standard thresholds published by the Global Fund. ⁸

---

The screenshot below provides an example of programmatic thresholds set for the three indicators selected. Note that the thresholds in the example below are different than those shown in the tables above.

<table>
<thead>
<tr>
<th>Green</th>
<th>Greater than or equal to 90% (≥90%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>Less than 90% and greater than or equal to 60% (≥60% and &lt;90%)</td>
</tr>
<tr>
<td>Red</td>
<td>Less than 60% (&lt;60%)</td>
</tr>
</tbody>
</table>

Once all programmatic thresholds are set, a “✓” appears next to the Programmatic Thresholds menu item as shown above.

3.9.2.  **STEP 9: PERIOD DATES CHECK. CONFIGURATION > GO TO SETUP>**

This step serves to verify reporting periods that were automatically generated by the application.

It is important for the PR to ensure that all collected data suit the predefined periods. It is expected that most PRs will enter and track data on a quarterly basis, as shown in the example below. In these cases, a PR with six-month reporting periods will have to split...
six-month periods into 3-month periods (quarters). PRs could also choose to enter and track data on a monthly basis.

As mentioned at the beginning of the configuration process, periods are generated automatically from the Phase Start Date entered in step 1, and a “✓” should have been automatically generated. However, if this first date is missing or incorrect then the periods will not be correct.

The period sheets displays information as follows:

<table>
<thead>
<tr>
<th>Period number (up to 12)</th>
<th>Corresponding calendar quarter &amp; year</th>
<th>Calendar quarter start date</th>
<th>Calendar quarter number per year</th>
<th>Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period 1</td>
<td>Q1-Q2</td>
<td>1-31 Jan 2011</td>
<td>2011</td>
<td></td>
</tr>
<tr>
<td>Period 2</td>
<td>Q3-Q2</td>
<td>1-31 Mar 2011</td>
<td>2011</td>
<td></td>
</tr>
<tr>
<td>Period 3</td>
<td>Q5-Q2</td>
<td>1-31 May 2011</td>
<td>2011</td>
<td></td>
</tr>
<tr>
<td>Period 4</td>
<td>Q7-Q2</td>
<td>1-31 Jul 2011</td>
<td>2011</td>
<td></td>
</tr>
</tbody>
</table>

If any error has been made in entering period dates, the PR should correct the error at this time. Once the PR has verified that the period dates are accurate, **CONFIGURATION** of the data-entry application is complete.

### 3.9.3. **CONFIGURATION > REMOVE SR WORKSHEET**

In exceptional situations, it may be necessary for the PR to eliminate one or several SRs. As much as possible, however, data on a dropped SR should remain within the data-entry application to ensure that historical data on the grant are complete. An example of an exceptional situation where an SR does need to be eliminated would be a PR with 49 SRs configured in the data-entry application that drops one SR and wishes to add another one. The new SR could not be added without liberating the tab of the dropped SR in the data-entry application. The situation should be exceptional, because less than 12% of all Global Fund grants are known to have more than 49 SRs.

It is strongly recommended that PRs needing to completely eliminate an SR from the data-entry application to free up extra space contact the Global Fund or GMS for assistance (see section 6) to ensure that deletion of SRs is conducted without compromising data for other SRs that has already been entered into the data-entry application.

There are two major steps for dropping an SR:

1. **Modify the name of the dropped SR to indicate that the SR was dropped and the date the SR was dropped.** The SR will appear in the dashboard visualization as a dropped SR, but no data will appear after the date that the SR was dropped.

2. **The replacement SR will be added in the remaining SR space(s) of the data-entry application.** The new SR's name in the data-entry application will reflect the period when it was added. See the example below for an SR – Save the Children - that
was active from periods one to three for a grant and which was dropped thereafter to be replaced by a new SR – World Vision - at period 4:

- New name for dropped SR: “Save the Children (Period 1-3)”
- Name for replacement SR: “World Vision (Period 4+)”

In the scenario where no more free SR spaces are available and the replacement SR must take the place of an old SR in the data-entry application, the old and new SR would essentially share the same SR data entry sheet. The PR would need to lock the cells of the reporting periods that precede the arrival of the new SR in the SR data entry sheet so that the new SR did not inadvertently enter data or alter data from prior periods.

The Remove SR worksheet option on the Menu page is the button that allows deletion of SR data-entry sheets. When this button is pressed, the application will show a dialogue box which permits elimination of one SR or of all SRs that have been created, as shown below.

If the user wishes to eliminate one SR, the user will have to select the SR from the list and confirm its elimination. If the user wishes to eliminate all SRs, the user will need to select the option “Eliminate all SRs created” and confirm its elimination as shown below.
Once all steps in this section 3.9.3 are completed, the PR presses the Return to Menu button and returns to the Main Menu.

### 3.9.4. STEP 10: REFRESH PROG INDICATORS LIST. CONFIGURATION > GO TO SETUP

Once steps 7 and 8 of the indicator CONFIGURATION process are done, the PR may wish to change or modify indicators (see section 3.8.6), or change the order of indicators (see section 3.8.5). Such modifications can be made by following the instructions described in the applicable sections of this User Guide and by subsequently pressing the REFRESH PROG INDICATORS LIST button on the submenu.

### 3.10. CREATE DATA INPUT FORM—PROCESS 2: SELECT EXPORT SHEET

Once the CONFIGURATION process, which is option 1, is complete such that all items in the PRSetup menu appear with green check marks, the PR will continue to CREATE DATA INPUT FORM, which is option 2. When option 2 is selected, a drop-down menu lists all PR and SR data-entry sheets already configured. Users should be aware that it is also possible to select the sheet that the PR wishes to export by using the Export data input form button which is found on the top right section of each SR data entry sheet, as shown below:
When an SR is chosen from the drop-down menu, the PR will see the following message.

3.11. EXCEL DATA-ENTRY APPLICATION—PROCESS 3: SR COMPLETES SR DATA-ENTRY SHEETS (DATA COLLECTION)

Prior to sending any SRs data-entry sheets to complete, the PR will train its SRs on how to complete the data-entry sheets correctly.

The PR can send SRs data-entry sheets using a variety of mechanisms. If the SR has good internet connectivity, PR can email the SR the data-entry sheet. Otherwise, the PR can provide the SR with the data-entry sheet on a USB or even on paper. If the SR is unable to fill out the data-entry sheet using a computer, the PR can obtain the data from the SR by other means (e.g. by phone or in person) and fill out the data-entry sheet on behalf of the SR.

The PR only needs to send the SR the file once, as the SR will update the same file and send it the PR for subsequent reporting periods. The SR should maintain the same file name to ensure that the PR Data Master will recognize the SR data file.

If the SR fills out the SR data-entry sheet electronically, the SR will rename the file once using the naming convention agreed on with the PR. An example of a logical name that SRs could give to files is SRNAME_DASHBOARD DATA_MONTHYEAR).
The PR should create a specific folder with the PR Dashboard folder it established initially to save all files with updated SR data. See section 3.1.1 of this User Guide.

The first time that the SR fills out the data-entry sheet, the SR is advised to closely examine the indicators in the sheet to ensure that only the indicators the SR is required to report on appear. If any indicators appear in the sheet with the SR is not required to report on, the SR should notify the PR immediately in order to obtain and updated, corrected sheet. The SR should also contact the PR if there are any indicators for which there is missing information.

**If the PR begins using the dashboard after the grant is well underway, the SR will need to complete historical data on its performance for previous reporting periods. This should be done carefully.**

When the SR first opens the data-entry sheet in Excel, a blank data-entry sheet will appear that contains only the indicators the SR is required to report on, as shown below:

<table>
<thead>
<tr>
<th>Object ID: CPU Affordable Medicines (UL) - Indicator</th>
<th>Comment</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 Budget PR (≥ SR)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.2 Disbursement PR (≥ SR)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3 Medications</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.4 Programmatic reports planned</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.4 Proc. of undernourished PTHV using therapeutic or suppl. in npt. period Target</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.5 Proc. of undernourished PTHV using therapeutic or suppl. in npt. period Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.6 FMR newly enrolled in welc care starting M target</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.7 FMR newly enrolled in welc care starting M Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.8 a/mr infants &lt;2mths old &amp; tested Target</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.9 FMR infants &lt;2mths old &amp; tested Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.10 FMR infants &lt;2mths old &amp; tested Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.11 FMR infants &lt;2mths old &amp; tested Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.12 FMR infants &lt;2mths old &amp; tested Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12.13 FMR infants &lt;2mths old &amp; tested Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13.14 FMR infants &lt;2mths old &amp; tested Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14.15 FMR infants &lt;2mths old &amp; tested Actual</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

With each subsequent reporting period, the data-entry sheet fills up. Each time the SR prepares the SR data-entry sheet to send to the PR, the SR fills out the column only for that reporting period. If the SR finds a need to correct or update data for prior periods, the SR should consult the PR prior to making any changes.

The SR will enter quarterly data into the blank cells. The SR should conduct verification (including physical verification, where applicable) of achievement of targets prior to entering data.

**Data for compliance indicators (indicators that track the SRs compliance with reporting obligations to the PR) should not be entered by the SR,** but should be left blank for data entry by the PR, as results for these indicators must be validated by the PR. Annex 5 details the responsibility for entering data for indicators in the dashboard.
When entering data, it is best to avoid taking shortcuts such as cutting and pasting data into the data-entry sheet. Shortcuts may disrupt programming in the Excel sheet.

Once each SR has finished updating its data-entry sheet, it sends the file to the PR using the transmission mechanism agreed to with the PR.

### 3.12. EXCEL DATA-ENTRY APPLICATION—PROCESS 4: DATA COLLECTION AND UPLOADING OF SR FILES

Once all updated data-entry sheets submitted by SRs are received, the PR should conduct a data quality check of the data submitted by the SR. Once the data quality check is completed, the PR will proceed to upload the files to the dashboard application. This is done by pressing the button **Load SR Data from File in the third menu option entitled “Data Collection”** shown in the diagram below.

When the button for option 3, **DATA COLLECTION>Load SR Data from File** is pressed the application will show a window where the PR may select the appropriate file submitted by each SR, previously saved in the corresponding folder.

The PR will select the file to be uploaded and press **Open**.
Then the following message will appear: “Data importation complete.” This importation process normally takes a few seconds for each SR.

The PR will press “OK” and then repeat this action for each of the SRs in the menu above until all updated data-entry sheets have been uploaded onto the dashboard application.

3.13. DASHBOARD DATA FEED—EXPORT MASTER DATA—PROCESS 5

Once all SR data-entry sheets are uploaded onto the application the PR will be ready to export the files that will be used to update the PR dashboard.

The file export process generates an Excel worksheet that will update the dashboard created using SAP software. This step is done by pressing the button 4) Dashboard Data Fee>Export Master Data.

When this is done the PR will see a window showing the destination folder where the export file will be saved as shown below:

Select the name of the destination folder and press “Open.”

The PR has two files “Dashboard Feed 2.0 R4” and “PR Dashboard Data Master_2.0 R4.” The PR should select “Dashboard Feed 2.0 R4” file from its documents library.

The PR’s computer will then show the following message:
The PR will press **Save** to ensure that the file name stays the same.

Then the following message will appear: “**Data export complete.**” This export process normally takes a few seconds for each SR.
The last step in this process is for the PR to record the date changes were made, the name of the person making changes, and all changes made. An example is shown below. The PR must then resave the file using the file's original name. The file should not be renamed.
4. STEP-BY-STEP INSTRUCTIONS FOR INSTALLATION AND ONGOING USE OF THE PR MANAGEMENT DASHBOARD APPLICATION

As you will recall from section 3 of this manual, the diagram below shows the flow of the PR Management Dashboard and guides the user through specific steps to follow to set up and use the PR Management Dashboard.

This section 4 explains “E” in the diagram, how to use the dashboard-display application, step by step.

4.1. INSTALLING SAP CRYSTAL DASHBOARD DESIGN 2011 (PR MANAGEMENT DASHBOARD SOFTWARE)

4.1.1. ENSURING THE VERSION OF EXCEL ON THE PR’S COMPUTER IS COMPATIBLE WITH DASHBOARD SOFTWARE
Before installing SAP Crystal Dashboard Design 2011, PRs will want to ensure that the computer being used to generate the dashboard is running is a 32-bit version of Excel (see system requirements in section 2 of the User Guide). The first part of this section 4.1.1 explains how to check which version of Excel exists on a given computer.

First, open any Microsoft Office application in your computer. In the example below, Word 2010 is being used, but the instructions apply also to lower versions of Office 2007; 2003) the other Office applications. Open the File menu, and then select Help.

A window will appear with information about your version of Microsoft Office. It will show the suite version and included applications, as well as your precise version number and product ID.

Under “Office Updates” you should see the version number. To see both version and platform, click About Word to see the information you need. This information will appear as follows:

In the example below, the version is listed as follows:

Version: 14.0.4760.1000 (32-bit)
If the PR’s computer has a 64-bit version of Excel, the PR will need to uninstall the 64-bit version of Microsoft Office. The PR will then need to reinstall Microsoft Office and select the 32-bit version upon reinstallation.

To reinstall Microsoft Office, the person with administrative rights to the computer where SAP Crystal Dashboard Design 2011 software is to be stored and used must be available to provide the password to execute this process. In some cases, the person who has administrative rights may not be the person who uses the computer on a daily basis – in many organizations, this person with administrative rights may be based in the information technology (IT) department of the organization.

The PR should follow the instructions provided on the Microsoft website for uninstalling and reinstalling Microsoft Office.

Once the correct version of Microsoft Excel is installed (32-bit), the PR is ready to install SAP Crystal Dashboard Design 2011.

4.1.2. INSTALLING THE DASHBOARD SOFTWARE

The technical support team will assist the PR with the installation process. The PR will have already created a folder called PR Dashboard (see section 3.1.1 of this User Guide) when installing the data-entry application. The technical support team arrives in the country with a USB file containing the zip file 51049596 and will install this file in this PR Dashboard folder. If internet connectivity is good, the technical support team can alternatively also help the PR download the ZIP file 51049596 from the following link:

https://www.dropbox.com/s/kh74jqwk8awswjw/51049596.zip?dl=0

Once the file is downloaded, carry out the following steps:

1. Right click on the title of the ZIP folder
2. Choose to extract all files
3. Double click on **Data Units**
4. Double click on **Xcelsius**
5. Open **Setup** application (shown in the following screenshot). **The name of the file may also appear as setup.exe.**

![Image](image.png)

Double click or right click on the file, and select **Open**.

A dialogue box will appear which shows that the dashboard software is being installed.

When this process ends a new window will appear asking for language selection as shown below. Choose your preferred language for set up and press "OK."

![Image](image.png)

You will now see a “welcome” screen. Select **Next** to access a new window showing a list of requirements to install the software.

![Image](image.png)
Please carefully review the list you now see on the page titled “Prerequisite check”, to make sure that there is no conflict with system requirements. If there is a conflict with the system, the word “Failed” will appear under the Status column. In case of conflict, you may stop the installation process by clicking **Cancel**. You should then take the necessary action (e.g., install correct version of Adobe Flash Player) to resolve the conflict, before resuming installation of SAP Crystal Dashboard Design 2011.

If there is no conflict, the world “succeeded” will appear under the status column for every item listed under the “prerequisite” column and you should click **Next** to continue installation.

**After clicking Next, the license agreement page will appear as shown below. Accept the terms of the license agreement by clicking Next.**

Then the following screen appears, which asks you to specify the “destination folder.” This is the folder or directory on the computer where the software you are installing will be saved. Confirm is done by pressing “Next.”. If the default folder that appears is not the place where you wish to save the software, you will need to click “browse” to select the correct destination folder. Once the folder has been specified, click **Next**.
Clicking **Next** makes a new screen appear asking for the user's name and product key as shown in the screen below. It is recommended that the PR enters its complete name and country under the fields “Full Name” and “Organization.” The PR must enter the software license number provided by GMS team in the “Product Keycode” field as shown below will provide. Once this information is entered, click **next** to bring up the next screen.

The next screen that appears asks you to “choose language packs” As shown below. English will already be selected as a default language. You may add Spanish or French or some combination of these languages, depending on what languages you will need to
use in your country. Note that although other languages are listed, they are not available for selection.) Click **Next**. once the languages you require are selected.

The following screen appears asking users to choose the type of installation. When this screen appears, “**Typical**” will be the default selection, and this is the installation that should be used. Once “**Typical**” is selected, select **Next**.

The next screen allows the user to start the installation process. The user should press **Next** to begin the process.
Next, installation begins, and a blue bar appears in the middle of the screen showing how quickly this step is completed, as shown below.

The screen on the following page will then appear as the software is launched.
At the end of the installation you will see the following screen. Follow the directions on the screen, and when you click Finish you will complete installation of the on the computer.
4.1.3. ADDITIONAL DASHBOARD SET-UP STEPS

Please follow the following steps to complete set-up of the PR Management Dashboard.

1. Open SAP Crystal Dashboard Design 2011 by pressing the icon under the All Programs menu

2. Once the software is open, Click on the File menu

![Image of SAP Crystal Dashboard Design 2011](image1.png)

3. Once the File menu is open, select New and then New again. See screenshot below.

![Image of selecting New](image2.png)

4. Change the rows setting by selecting File-> Select Preferences-> Select Excel Options -> Select Maximum Number Of Rows -> Change 512 to 2000. See the screen shot below as an example.

![Image of changing rows setting](image3.png)
5. **Change Language Setting** if needed as follows: Select **File** -> **Select**

6. **Preferences** > Select **Languages** > Select **Current Language** > Change **English** to **French** or to **Spanish**. By changing the language, the user will cause all labels in the software to appear in the selected language. Users will therefore want to select their preferred working language during this step. Notice that the language choices mirror the language packs that were selected during installation of the software.
4.2. NAVIGATING THE DASHBOARD

4.2.1. IMPORT GRANT DATA INTO PR MANAGEMENT DASHBOARD

This section explains how to import data from the PR’s master data sheet into the dashboard and to subsequently view the data for that given period in the PR Management Dashboard. The numbered steps below match what is shown in the numbered images in the flowchart that follows.

1. Click on the icon in the far lower left side of your computer and select the icon for SAP Crystal Dashboard Design 2011 under the “All Programs” menu

2. A screen appears with the word “Dashboards” shown.

3. Open the program by pressing File in the upper left corner of the screen and selecting Open.

4. A dialogue box will appear with a file library. Select the file “PR Dashboard.” In the example below, the file is Dashboard 2.0 R4. However, the latest version of the PR Management Dashboard will be “Dashboard 2.0 R4,” and that is what you will see on the screen.

5. The PR Management Dashboard file will open. This file contains the PR Management Dashboard design, so you do not need to make any changes or modifications to it.

** Please note: In some instances, you must choose Right click → Run as administrator for Dashboards in order to get this program to work. This is due to a lack of permissions on the host computer.
4.2.2. **DATA IMPORT INTO THE PR MANAGEMENT DASHBOARD**

This section explains how the PR imports the grant data from the Excel sheet so that the PR Management Dashboard can be produced.

From the menu, the PR selects the icon that means “import Excel sheet” and presses “yes.”
Next, the PR selects the PR Dashboard feed file where all the latest PR and SR data are saved. In the example below, the file is named Dashboard Feed2.0.xls, which, as shown in the screenshot below, corresponds to the most recently updated version.

A few seconds later, the PR Management Dashboard will display updated PR and SR data.
4.2.3. VISUALIZATION OF THE PR MANAGEMENT DASHBOARD

The PR Management Dashboard software allows generation of output files in different formats, which may be selected by checking menu options or by clicking File>Export>. Each possible format is listed below with a brief explanation of how to use that format.

Available options include:

**Flash (SWF):** to preview
**AIR:** to download using Adobe Flex software
**HTML:** to preview using Internet Explorer
**PDF:** to create a file that can be submitted in a report
**PowerPoint:** to create a “PPT” slide that can be used in a PowerPoint presentation
**Outlook:** to be attached to an email
**Word:** to be used as a report or annex
5. THE PR MANAGEMENT DASHBOARD IN DETAIL

The following pages provide additional explanations about the information appearing in each section of the PR Management Dashboard. There is an image and a comment box for each image.

Each comment box also includes the reference number for the indicator concerned. Lists of indicators are found in annexes 2, 3, 4, and 7 of this document.
1. This section of the PR Management Dashboard shows a grant’s basic information, which includes the latest grant rating, the country name, grant number, the name of the PR, the grant start and end dates, as well as the current period being displayed in the dashboard.

2. This part of the PR Management Dashboard shows the two key financial management indicators for the grant—the percentage of the budget to date that has been disbursed by the Global Fund to the PR and the percentage of the budget to date that the PR and SRs have spent. (Indicators F1 and F2 in annex 2)

3. The PR selects the two programmatic indicators it considers the most important to appear in this section of the PR Management Dashboard. (Indicators listed in annex 7)

4. The three health products that the PR considers the most important to track are displayed here. The number of months of stock remaining for each product is displayed on the right-hand side. (Indicator P6 in annex 4)
5. The number of months of available stock of the three highest priority health products requiring monitoring is shown here. *(Indicator P6 in annex 4)*

6. By clicking on More the PR can expand this section and view the number of months of stock available for up to 20 health products. *(Indicator P6 in annex 4)*

7. This section shows what the expanded list of health products looks like. *(Indicator P6 in annex 4)*

8. Using four colors, this legend explains the threshold at which each color appears when months of physical stock are compared to months of safety stock. See annex 6 for a more detailed explanation of this indicator.
9. The section gives a financial overview of the grant. On this graph, the PR is able to compare how much funding has been disbursed by the Global Fund compared to PR budget for any given period, as well as how much the PRs and SRs have spent. Data are cumulative by reporting period. *(Indicator F5 from annex 2)*

10. This section allows the PR to see how much has been committed and spent compared to what was budgeted for various health product procurement-and-supply management-related items. *(Indicators P8, P9, and P10 from annex 4)*

11. Here, the PR is able to see the status of conditions precedent, special conditions, Office of the Inspector General recommendations, audit recommendations, and time-bound actions. Yellow and red results indicate the need to take action. *(Indicators F4, G5 G6, G7 from annexes 2 and 3)*
12. The PR selects up to 15 indicators from the grant’s complete performance framework to appear on in this section. Data for the remaining indicators are retained within the grant’s Master Data sheet. (Programmatic indicators from annex 7)

13. Results for several general management indicators are shown here. Indicators are related to progress in project recruitment, status of supervisory visits, incidence of stock outs, status of planned health product procurement, timeliness of health product deliveries and results of health product quality assurance tests. (Indicators G1 and G4 from annex 3 and indicators P1, P2, P3, P4, P5 from annex 4)

14. This section shows whether various reports needed by the PR to manage the grant are on time or overdue. (Indicator F3 from annex 2, G2 and G3 from annex 3 and P7 from annex 4)
15. Clicking on this link allows the user to drill down to SR level of data.

16. Shown here is individual SR data on expenditure against budget. Percentages represent percentage of actuals achieved compared to targets. Each SR appears on a different row. Data for all periods elapsed for the grant are visible. By clicking at the top of the grant, SRs can be organized in order of performance. (Indicator F6 in annex 2)

17. By clicking on the “X” here, the user is able to collapse the page showing SR details related to finance indicators and return to the main page of the dashboard.

18. This section allows users to view historical SR expenditures compared to the budget for the each period. These data are not cumulative. (Indicator F7 in annex 2)

19. This section allows dashboard users to view SR expenditures compared to the budget and disbursements for the same period. Information is cumulative. Comments made by the SR to explain its performance appear under the PR name listed here. (Indicator F8 in annex 2)
20. Clicking on this link allows the user to see comments made on PR committments to the Global Fund.

21. Here, users can see comments about conditions precedent and other committments that the PR has to the Global Fund.

22. By clicking the “X” here, the user can close the comment box.
23. Percentage attainment of actuals against targets for up to 15 programmatic indicators is shown in this section. Indicators appearing here are initially selected by the PR during set up of the dashboard. Data on the remaining indicators remain stored in the master data sheet. By changing prioritization of indicators in the PR Master Data File, the PR can change which indicators appear in this section.

24. This section allows viewing of programmatic indicators by SR. Only the SRs contributing to the indicator appear. (Indicators from annex 7)

25. This section allows viewing of trends for specific programmatic indicators by SR. Any comments made by the SR to explain performance appear under the SR name. (Indicators from annex 7)

26. Clicking here allows the dashboard user to collapse SR data and return to the PR level data.
27. By clicking on this link, the dashboard user can view individual SR performance on timeliness and completeness of reporting. *(Indicators F3 from annex 2, G2 and G3 from annex 3 and P7 from annex 4)*

28. Dashboard users can view SR performance on completeness and timeliness of reporting in this section. Clicking on the “x” allows the user to collapse SR detail and return to the main page of the dashboard. *(Indicators F3 from annex 2, G2 and G3 from annex 3 and P7 from annex 4)*
6. TROUBLESHOOTING: BEST PRACTICES, FREQUENTLY ASKED QUESTIONS (FAQS) AND THE HELP DESK

6.1. FAQS ON THE DATA-ENTRY APPLICATION

I OPENED THE DATA-ENTRY APPLICATION AND GOT A WARNING MESSAGE OF A MACRO. I CANNOT PROCEED WITH DATA-ENTRY APPLICATION SET-UP. WHAT DO I DO?

Clicking “Enable Content” this should allow you to open the data-entry application and begin working in it.

MY FIRST LANGUAGE IS NOT ENGLISH. ARE THERE OTHER LANGUAGE VERSIONS OF THE DATA-ENTRY APPLICATION?

You can change all the labels, instructions and error messages of the data-entry application to French or Spanish by selecting “French” or “Spanish” in the drop-down menu of the “Language” in the PR set up menu.

THE PR WISHES TO CHANGE INDICATORS. CAN THIS BE DONE?

Financial, management and procurement and supply management indicators should not be changed, as attempting to change indicators will interfere with the structure and design of the PR Management Dashboard, which may cause parts of PR Management Dashboard to stop working. Therefore, it is best NOT to change financial or management indicators. However, if the PR wishes to modify programmatic indicators, this can be done following the process described in section 3.8.6 of this User Guide.
IS IT NECESSARY TO DEFINE THRESHOLDS FOR EACH INDICATOR? CAN THE SAME THRESHOLD BE USED FOR EACH INDICATOR?

Thresholds must be defined for each programmatic indicator. Each threshold will be determined by the PR; however, it is best to standardize thresholds across the programmatic indicators so that results for this category of indicators may be comparable and meaningful.

Thresholds must also be defined for two of the financial indicators.

Furthermore, PRs must define the safety-stock levels in months for each of the commodities being monitored.

For other indicators (such as management indicators), the thresholds are automatically defined.

Recommendations are made for thresholds for various types of indicators in this User Guide. PRs are advised to determine thresholds during the indicator workshop in the early stages of introducing a dashboard.

PR FINANCIAL AND PROGRAMMATIC DATA ARE TRACED IN 6-MONTH PERIODS. IS IT POSSIBLE TO USE 6-MONTH PERIODS IN THE PR MANAGEMENT DASHBOARD?

The PR Management Dashboard is designed to enter data on a quarterly basis. If the PR has 6-month data they should be disaggregated in quarterly portions so they may be entered in the PR Management Dashboard.

WHOM DO I CONTACT IF I ENCOUNTER A COMPLEX PROBLEM WITH USING THE PR MANAGEMENT DASHBOARD (E.G., I ACCIDENTLY Disable KEY FORMULAS)?

If you are using the PR Management Dashboard in the context of a GMS technical assistance assignment, you should obtain technical assistance from the GMS team assigned to help you. Otherwise, contact the Global Fund Help Desk at GFSupport GFSupport@theglobalfund.org.

WHILE CONFIGURING THE PR MASTER DATA SHEET, THE NUMBER OF SR WORKSHEETS CREATED WAS NOT THE SAME AS THE NUMBER OF SR NAMES ENTERED. WHAT SHOULD I DO? Users should ensure that they have on the button for Step 3 of configuration -- “Create SR worksheets” – after having entered names of SRs into the PR/SR Name column in the Page set up tab. In the alternative, click the “Refresh Worksheet List"button to execute the same function.
The user should then check the the number in the cell adjacent to the “Total SRs created” to see of the number appearing their reflects the number of SR names listed. If there is a discrepancy between the two, users should check that formulas in the workbook are up to date. This can be done by clicking Calculate Now using the Formulas menu or F9 on the keyboard for a manual one-off calculation of formulas.

Alternatively, formulas can be set to automatic via the Formulas menu, as shown in the screenshot below.

If the problem persists, contact GMS or Global Fund Help Desk as applicable.

**SRs are complaining that when they enter data into the SR data-entry sheets, they cannot expand the column width, as the data-entry sheets are locked. When figures entered by the SR are longer than the column width, this makes data entry difficult. What can be done to make data entry easier for the SR?**

Under the “Review” menu of the excel worksheet, select “Protect Sheet” and type in the password “p” in the “Password to unprotect worksheet” box, then press “OK.” Then widen the columns as needed. It is recommended that the worksheet be protected again after the columns are widened to prevent inadvertent loss of formatting.
6.2. **FAQS ON THE PR MANAGEMENT DASHBOARD**

**CAN I USE SAP CRYSTAL DASHBOARD 2011 SOFTWARE ON MY MAC COMPUTER?**

No, SAP Crystal Dashboard Design 2011 software is not compatible with Mac computers as of the publication of this *User Guide*.

**IS SAP CRYSTAL DASHBOARD DESIGN 2011 COMPATIBLE WITH WINDOWS 2013?**

No, it is not compatible as of the publication of this *User Guide*.

**SHOULD I UNINSTALL THE DASHBOARD SOFTWARE FROM MY OLD COMPUTER BEFORE INSTALLING IT IN THE NEW ONE? AND WHICH ACTIVATION KEY SHOULD I USE?**

Yes, please uninstall the software from your old computer and then use the license key from that installation for your new computer.

**I CHECKED MICROSOFT OFFICE ON MY COMPUTER AND DISCOVERED THAT I HAVE A 64-BIT VERSION OF EXCEL. CAN I STILL INSTALL THE SAP CRYSTAL DASHBOARD DESIGN 2011 SOFTWARE SUCCESSFULLY?**

No, you will not be able to successfully install SAP Crystal Dashboard Design 2011 software until you uninstall the 64-bit version of Microsoft Office and reinstall Microsoft Office. You will then need to select the 32-bit version upon reinstallation. Follow the instructions provided on the Microsoft website for uninstalling and reinstalling Microsoft Office. You will need administrative rights to the computer you are using to do this uninstallation and reinstallation.

**I GENERATED THE PR MANAGEMENT DASHBOARD IN POWERPOINT BUT IT DOES NOT SHOW IN THE SLIDE. WHAT CAN I DO?**

To visualize the PR Management Dashboard using PowerPoint you must click the icon to show slides at the bottom of the screen or click the F5 key on your keyboard.

In the alternative check that you have version 15 of Adobe Flash Player as Adobe Flash Player is necessary to view the dashboard in PowerPoint.

**I GENERATED THE PR MANAGEMENT DASHBOARD IN ADOBE. HOWEVER, I CANNOT SEE THE DASHBOARD – THE PAGE IS BLANK. WHAT CAN I DO TO ADDRESS THIS?**

Check to see that you have the latest version of Adobe Reader (version 11 and up). If your version is out of date, update it immediately.

**I SUCCESSFULLY EXPORTED THE FILES FROM THE PR MASTER DATA SHEET TO THE PR MANAGEMENT DASHBOARD. HOWEVER, I CANNOT SEE THE GRAPHS AND OTHER VISUALS OF THE PR MANAGEMENT DASHBOARD. WHY DOES THIS HAPPEN?**

Please check that Adobe Flash Player Version 15 or higher is installed on your computer. To check, go to the Windows icon on the bottom far left side of your computer and select “all programs.” If Adobe Flash does not appear, go to [http://get.adobe.com/flashplayer/](http://get.adobe.com/flashplayer/) to download Adobe Flash Player Version 15.

When working in the PR Management Dashboard file, I encountered an error message that says “component busy” as shown below. What should I do?

![Component Busy](image)

You should close all instances of Excel that are currently open and hit **Retry**. Repeat this action again if it does not work the first time.

I generated the dashboard in an interactive file format in Word. However, it appears quite small, and expanding it is not easy. What should I do?

You will need to access the “Developer” section in the dashboard-display application. By default, the Developer section does not display. However, it can be added to the toolbar. To show the Developer section, do the following:

1. Open the Word file and click on **File**
2. In the File menu, go to **Options**

![Options](image)
3. Click **Customize Ribbon**.

4. Under Customize the Ribbon and under Main Tabs, select the check **"Developer."**
5. Once installed, it is possible to modify the size of the object by selecting the option: “Design Mode.” This option shows the borders of the dashboard pages and allows changing of the size of the file.

6. Click on “Design Mode” one last time.

6.3. HOW TO GET HELP WITH THE PR MANAGEMENT DASHBOARD

The Global Fund has established a Help Desk to ensure that both simple and complex problems that may arise with use of the data-entry application or PR Management Dashboard application are addressed promptly and effectively. Technical assistance provider Grant Management Solutions also has a Help Desk – however, the GMS Help Desk serves only GMS clients and GMS technical assistance teams.

The Help Desk will operate on the assumption that most problems arising with use of the PR Management Dashboard can be addressed by referring to this User Guide or any technical assistance team that is assisting the PR and SRs with the PR Dashboard introduction and use. Should problems arise that require more advanced technical help however, additional assistance is provided through the Help Desk to rapidly resolve any issue; a response to this kind of request will be given within 48 hours.
The following table summarizes the approach to troubleshooting and resolution of problems with PR Management Dashboard use:

<table>
<thead>
<tr>
<th>Nature and timing of the problem</th>
<th>Where to get help</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The PR, SR or technical assistance team needs to execute normal tasks or procedures to use the PR Management Dashboard and requires instruction. Timing could be during technical assistance visits or in between visits.</td>
<td>User Installation and Set-Up Guide</td>
<td>Not applicable</td>
</tr>
<tr>
<td>2. During an in-country visit, a technical assistance team experiences a fundamental problem with the technology or functioning of the PR Management Dashboard solution that it cannot resolve</td>
<td>Consultants on the technical assistance teams. PRs obtaining help from GMS should contact GMS. All others should contact The Global Fund.</td>
<td>In person or through email GMS Help Desk contact: <a href="mailto:GMSHelpdesk@gmsproject.org">GMSHelpdesk@gmsproject.org</a> Global Fund Help Desk contact: <a href="mailto:GFSupport@theglobalfund.org">GFSupport@theglobalfund.org</a> A response will be provided within 48 hours of receiving the message You may send emails to these addresses in English, French or Spanish</td>
</tr>
<tr>
<td>GMS consultants to contact GMS Help Desk All others should contact the Global Fund.</td>
<td>GMS Help Desk contact: <a href="mailto:GMSHelpdesk@gmsproject.org">GMSHelpdesk@gmsproject.org</a> Global Fund Help Desk contact: <a href="mailto:GFSupport@theglobalfund.org">GFSupport@theglobalfund.org</a> A response will be provided within 48 hours of receiving the message You may send emails to this address in English, French or Spanish</td>
<td></td>
</tr>
</tbody>
</table>